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Starting a Project 

Deciding to Use NVivo 
NVivo is designed to help you manage and analyze data that is not easily reduced to 
numbers.  In NVivo, you can create a project to store documents, organize documents, attach 
ideas (known as Nodes in NVivo) to text, and find patterns among your ideas.  Just like using 
Microsoft Word, NVivo is a tool that can be used in many ways to achieve your goals.  There 
is not one prescribed way to use the software.  This course is designed to introduce you to the 
basic features of NVivo so that you can manipulate the software to analyze data in ways that 
complement your research design. 

Picture 1: Opening Screen for NVivo 

Opening NVivo and starting a new project: 

1. Open NVivo (with a normal installation, you 
should see a QSR folder in your start menu, 
which contains the shortcut to NVivo). 

2. In the Opening Screen for NVivo (see Picture 
1), select the Create a Project button.   

 

3. A New Project Wizard: Setup – NVivo dialog box will appear.  Select the radio button 
for Typical and click on Next >. 

4. In the next window, type a name for your project in the Name: text box, then click on 
Next >. 

5. In the A New Project Wizard: Review – NVivo dialog box, review all of your information 
to ensure its accuracy and click on Finish. 

6. You will be taken to your Project Pad (see Picture 2). 

Picture 2: Project Pad 
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Managing Documents 

Preparing Your Documents 
All documents to be imported into NVivo need to be saved into Rich Text Format (.rtf).  
Rich Text Format will preserve basic formatting (bold, italics, text color, typeface, font size), 
but will not preserve tables or images.  In NVivo, you can link your tables and images to 
documents using DataBites (instructions for doing so are included later in this document, but 
will not be covered in the course).  

Helpful tip:  Prior to converting your files, create a new folder on your computer where you 
will store all of your NVivo Rich Text Documents.  This folder should be somewhere that 
you will remember so that you can find it easily later. 

To convert Microsoft Word Documents to Rich Text Format: 

1. Open your document in Microsoft Word. 

2. Click on the File Menu and select Save As…. 

3. In the Save As dialog box, click on the pulldown menu next to Save as type and select 
Rich Text Format (*.rtf). 

4. Use the Save in pulldown menu to select a location where you will be able to find your 
newly saved file later. 

5. Click on Save. 

Helpful tip:  Name your files so that they help you identify the content of the document.  For 
example, you could name a document InterviewDebbie051605.rtf to tell yourself that this 
document is an interview with Debbie that was conducted on May 16th, 2005. 

Importing Your Documents 
To import your Rich Text Documents into NVivo: 

1. From the Project Pad, under the Documents tab (see Picture 3) select the Create a 

Document button ( ).   

2. In the New Document Wizard: Creation dialog box, click on the radio button to Locate 
and import readable external file(s), click on Next >.  

3. In the Select File To Read dialog box, use the Look in: pulldown menu to locate the file 
you would like to import.   

4. Single click on the Rich Text Document you would like to import and click on Open. 

5. In the New Document Wizard: Obtain Names dialog box, click on the radio button next 
to None of the above. and click on the Next > button. 
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6. In the New Document Wizard: Name dialog box, type in a name for your document on 
the Name: text box and type in a description of your document in the Description: text 
box. 

7. Click on the Finish button.  

Picture 3: Project Pad – Documents Tab 

Browsing Documents 
You can easily view and edit documents that you have imported into NVivo by using the 
Browse feature.  

To view and edit documents: 

1. From the Project Pad, under the Documents tab select the Browse a Document button 
( ).   

2. In the Choose Document dialog box, use the Look in: pulldown menu to locate the file 
you would like to browse. 

3. Single click on your file and click the OK button. 

4. Your document will appear in the Document Browser window.   

5. You can simply view your document or edit your document in the Document Browser.  
(Caution: changes that you make to your document in the Document Browser will 
automatically be saved and cannot be reversed.) 

Helpful tip: You can also browse documents from the Document Explorer window by 

selecting the document you would like to view and clicking on the Browse button ( ). 
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Creating New Documents 
You can make new documents in NVivo by using the Create New Document feature.  

To create a new document: 

1. From the Project Pad, under the Documents tab select the Create a Document button 
( ). 

2. Select the radio button to Make a new blank document.  If this new document is a memo, 
check the box next to Create document as a memo (this will categorize the document as a 
memo). 

3. In the Name: text field, enter a name for your new document.  

4. In the Description: text field, enter a description for your new document. 

5. Click on the Finish button. 

6. The Document Browser will appear with your new document.  Enter your text into the 
new document. 

Organizing Documents 
You can organize your documents into sets so that documents that are of the same type can 
be easily identified.  In addition, you can assign attributes to each document to help organize 
and sort your documents.   

Organizing your documents into sets: 

1. From the Project Pad, under the Documents tab select the Explore Documents button 
( ).   

2. The Document Explorer (see Picture 4) will appear. 

3. Click on the Tools menu and select Create Set. 

4. A new set will appear under the Sets button ( ).   

5. To give your new set a name and description, click on the Set menu and select 
Inspect/Change Set’s Properties. 

6. In the Title: text area, enter a name for your new set. 

7. In the Description: text area, enter a description for your new set. 

8. Click the OK button. 

9. Now we will insert documents into our new set.  Click on the All Documents button 
( ). 

10. All of the documents in your project will be listed in the right hand side of the Document 
Explorer. 
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11. Drag and drop each of the documents that are appropriate for your new set into the 

Folder button ( , in this case my set is called “New Set”) for your new set. 

12. To ensure that your documents have safely arrived, click on the Folder icon for your new 
set. All of the documents that are now members of that set will appear on the right hand 
side of the window.  

Picture 4: Document Explorer 

 

To assign attributes to a document: 

1. From the Project Pad, under the Documents tab select the Explore Document Attributes 
button ( ).   

2. The Document Attribute Explorer (see Picture 6) will appear.  All of your documents 
will be listed in the first column.  As you add attributes, new columns will appear for 
each attribute. 

Picture 5: Create/Edit Document Attribute 

3. Click on the Attribute menu and select New 
Attribute…. 

4. In the Create/Edit Document Attribute window(see 
Picture 5), type a name for your attribute in the text 
area under Type the new attribute name:. 

5. To give your new attribute a description, type a 
description for your new attribute in the text box under 
Description:. 

6. Choose the appropriate type of attribute in the 
pulldown menu under Value type:.  (String should be 
used for all text based attributes, Boolean should be 
used only for true/false attributes, and number can be used for all numerical attributes.) 
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7. Once all of your values are set, click on the Apply button.  Your new attribute will appear 
on the left hand side of the window. 

8. To assign values to your new attribute, highlight your new attribute and click on the 
Value tab.  If you chose Boolean value type, default values of True and False will already 
be created for you.  For numerical and string value types, you will need to create values 
for your attribute.  To do so, select the radio button next to Create new value and type the 
value into the text area under Create new value. 

9. Once you have given your value a name, click on the Apply button.  Your new attribute 
value will appear in the left hand side of the screen.  Continue this process until all new 
values have been added for your attribute. 

10. When you have completed adding attributes and values, click the Close button.   

11. This will return you to the Document Explorer, where your new attributes will appear as 
columns. 

12. To assign attributes to your documents, right click on each of the cells and select the 
appropriate value for each document and attribute pair.   

Picture 6: Document Attribute Explorer 
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Understanding Nodes 

Nodes are the equivalent of placing sticky notes on a document to remind you that a 
particular passage is important.  In NVivo, you use nodes to code your documents.  Unlike 
sticky notes, the nodes you create in NVivo are searchable and easily merged, organized, 
deleted, or changed.  You can either let your nodes emerge as you code or you can establish 
your nodes before coding.  Either way, you can always change your nodes later.  

Types of Nodes 
Free nodes: Ideas that haven’t been linked to other ideas. 

Trees nodes: A hierarchical structure for categories (confidence) and subcategories (high, 
low) of ideas. 

Case nodes: Allow you to group cases (teachers) and then to have case nodes for specific 
teachers (Jack, Jane, Jill). 

Coding Data by Creating New Free Nodes 
To attach a new node to text: 

1. From the Project Pad, under the Documents tab select the Browse a Document button. 

2. Using the Look in:  pulldown menu, choose the document you would like to code.  Click 
the OK button. 

3. Highlight the text in your document that you would like to code. 

4. On the bottom of the screen, you will see the Coding Bar (See Picture 7).  In the 
pulldown menu you can type in a new node.  Once you have entered the appropriate 
node, click on the Code button next to the pulldown arrow. 

5. The highlighted text will now be coded. 

6. To ensure your text has been coded, you can view Coding Stripes for your document.  In 
the View menu, select Coding Stripes.  This will open a new frame in your Document 
Browser that shows which nodes are associated with specific pieces of text. 

7. Your new node will be categorized as a free node until you organize it into a tree or case 
node. 

Picture 7: Coding Bar 

 

The Faculty Exploratory is located on the second floor of the Harlan Hatcher Graduate Library. 
exploratory@umich.edu    |   http://www.lib.umich.edu/exploratory |   (734) 647-7406. 

rev: 5/26/05 
8 of 19 



Introduction to NVivo 
A Faculty Exploratory Workshop 

Coding Data by Using Established Nodes 
To attach a previously created node to text: 

1. From the Project Pad, under the Documents tab select the Browse a Document button. 

2. Using the Look in:  pulldown menu, choose the document you would like to code.  Click 
the OK button. 

3. In the Coding Bar, click on the Coder button.  This will open the Coder Window (See 
Picture 8).  The coder window will outline all of the nodes you have created. 

4. Highlight the text in your document that you would like to code. 

5. Using the Coder Window, highlight the node you would like to attach to the highlighted 
text and click on the Code button. 

6. The highlighted text will now be coded. 

7. To ensure your text has been coded, you can view Coding Stripes for your document.  In 
the View menu, select Coding Stripes.  This will open a new frame in your Document 
Browser that shows which nodes are associated with specific pieces of text. 

Picture 8: Coder Window 

 

Creating Nodes in the Node Explorer 
To create new nodes: 

1. From the Project Pad, under the Nodes tab (see Picture 9) select the Explore Nodes 
button ( ). 

2. In the Node Explorer (see Picture 10), right click on the type of node you would like to 
create (free, tree, or case).  From the menu that appears, click on the Create (Free, Tree, 
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or Case Type) Node option.  This will create a new node under the appropriate node 
type.   

3. To rename the node, highlight the new node and click on the Node menu.  From this 
menu, click on the option to Inspect/Change Node’s Properties.   

4. In the Properties window, in the text area under Title: insert a name for your new node. 

5. In the text box under Description: insert a description for your new node. 

6. After entering all of the information for your new node, click on the OK button. 

Picture 9: Project Pad – Node Tab 

 

Nodes Tab 

Picture 10: Node Explorer 
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Managing Nodes 
To organizing free nodes into tree nodes: 

1. From the Project Pad, under the Nodes tab, select the Explore Nodes button. 

2. In the Node Explorer, expand the tree nodes you have created by double clicking on the 
tree node icon ( ). 

3. Single click on the Free node icon ( ), so that your free nodes are listed on the 
right hand side of the window.   

4. Select the free node you would like to reorganize and drag and drop (click and hold your 
click on the node while also using the mouse to move the node across the screen until it is 
on top of the appropriate tree node) it onto the tree node where you would like it to be 
coded. 

5. Your free node will now be reorganized into the tree hierarchy. 

Browsing All Text Coded by a Node 
To browse text coded by a node: 

1. From the Project Pad, under the Nodes tab, select the Explore Nodes button. 

2. In the Node Explorer, select the node you want to see coded text for and click on the 

Browse button ( ).  This will open the Node Browser window that will list all text 
coded at the selected node.   
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Finding Relationships and Patterns 

Searching Your Data 
There are three primary searches available in NVivo, single item, Boolean, and proximity.   

Single item searches:  allow you to find all instances of one item (text, node, or attribute 
value) in your documents.   

Boolean searches: allow you to search for multiple items at the same time using logic 
operators (and, or, not, less) that define how those items should be searched.   

Proximity searches:  allow you to find places where two items (text patterns, attribute 
values, nodes) appear near each other in the text.   

To search your data: 

1. From the Project Pad, click on the Search button ( ).  This will open the 
Search Tool window (see Picture 16). 

2. In the Find: portion of the Search Tool window, click on the type of search you would 
like to perform (single item: Text…, Node…, Attribute Value…; or, multiple items: 
Boolean, Proximity). 

3. After selecting the appropriate single item or multiple item search, a new window will 
appear: 

For single item text searches: 

Picture 11: Text Search 

a) Type in the text you would like to search for in the 
text area next to Search for this text:.   

b) In the text area next to Name:, the default is for your 
search results to appear as a new node under 
“/Search Results/Single Text Lookup”.  Highlight the 
words “Single Text Lookup” and replace those words 
with a new name for your node that will represent 
the search you are completing.  Click on the OK 
button. 

c) This will return you to the Search Tool window, click on the Run Search button. 

d) The results of your search will now be available as a new node (named as you 
specified in step b) in the node tree “Search Results”. 

The Faculty Exploratory is located on the second floor of the Harlan Hatcher Graduate Library. 
exploratory@umich.edu    |   http://www.lib.umich.edu/exploratory |   (734) 647-7406. 

rev: 5/26/05 
12 of 19 



Introduction to NVivo 
A Faculty Exploratory Workshop 

For single item node searches: 

Picture 12: Node Search 

a) Click on the Choose… button.  

b) Using the Look in: pulldown menu, find the node you 
would like to search for.   

c) In the text area next to Name:, the default is for your 
search results to appear as a new node under “/Search Results/Single Node 
Lookup”.  Highlight the words “Single Node Lookup” and replace those words 
with a new name for your node that will represent the search you are completing.  
Click on the OK button. 

d) This will return you to the Search Tool window, click on the Run Search button. 

e) The results of your search will now be available as a new node (named as you 
specified in step c) in the node tree “Search Results”. 

For single item attribute value searches: 

Picture 13:Attribute Search 

a) Use the Choose a value window to find the attribute 
value you would like to search for. 

b) Choose the mathematical operator (equals to, does not 
equal to, greater than, less than, etc.)  that best 
represents what you are searching for.   

c) In the text area next to Name:, by default your search 
results will appear as a new node under “/Search 
Results/Single Attribute Lookup”.  Highlight the words “Single Attribute Lookup” 
and replace those words with a new name for your node that will represent the 
search you are completing.  Click on the OK button. 

d) This will return you to the Search Tool window, click on the Run Search button. 

e) The results of your search will now be available as a new node (named as you 
specified in step c) in the node tree “Search Results”. 
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For multiple item Boolean searches: 

Picture 14: Boolean Search 

a) Select the logic operator that best represents the type 
of search you are interested in completing from the 
Operator: pulldown menu. 

b) Use the Choose Nodes…, Choose Attribute 
Values…, and Choose Text Patterns buttons to select 
the items you would like to use in your search. 

c) In the text area next to Name:, the default is for your 
search results to appear as a new node under 
“/Search Results/Name of Logic Operator”.  
Highlight the “Name of Logic Operator” portion of that field and replace the 
name of your logic operator with a new name for your node that will represent the 
search you are completing.  Click on the OK button. 

d) This will return you to the Search Tool window, click on the Run Search button. 

e) The results of your search will now be available as a new node (named as you 
specified in step c) in the node tree “Search Results”. 

For multiple item proximity searches: 

Picture 15: Proximity Search 

a) Select the logic operator that best represents the 
type of search you are interested in completing 
from the Operator: pulldown menu. 

b) Use the Choose Nodes…, Choose Attribute 
Values…, and Choose Text Patterns buttons in the 
Find places where text is referenced by this item… 
area to select your first item. 

c)  Use the Choose Nodes…, Choose Attribute 
Values…, and Choose Text Patterns buttons in the 
…is near text referenced by this item area to select 
your second item. 

d) Using the …within this distance…  area choose the 
distance you want these two items to be near each other. 

e) In the text area next to Name:, the default is for your search results to appear as a 
new node under “/Search Results/Name of Logic Operator”.  Highlight the “Name 
of Logic Operator” portion of that field and replace the name of your logic 
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operator with a new name for your node that will represent the search you are 
completing.  Click on the OK button.  

f) This will return you to the Search Tool window, click on the Run Search button. 

g) The results of your search will now be available as a new node (named as you 
specified in step e) in the node tree “Search Results” 

Picture 16: Search Tool 

 

Identifying Relationships in Your Data Using the Show and Assay Tool 
The show and assay tools are used to help you identify patterns in your data.  The show tool 
will allow you to quickly browse through items coded at nodes, documents, attributes, 
attribute values, and sets (the bulleted list below describes each of the items you can display).  
The assay tool will create a table that identifies if a document has been coded by a particular 
node, set, or value.   

To open the show tool, go to the Project Pad and select the Show Relations button 

( ).  This will open the Show Tool window (see Picture 17). 
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Picture 17: Show Tool 

 

Using the Show menu in the Show Tool, you can display: 

• All of the nodes within a document (Nodes coding document…) 

• All of the documents that have been coded by a particular node (Documents coded at 
node…) 

• Members of a document or node set (Members of set…) 

• Values associated with an attribute (Values of Attribute…) 

• Documents and nodes that have been assigned specific values (Docs/Nodes with value…) 

• Memos that are attached to specific documents and nodes (Memos for…) 

To open the Assay Tool from the Document Explorer or  Node Explorer, click on the 

Assay button ( ).  This will open the Assay Tool window (see Picture 18). 
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Picture 18: Assay Tool 

 

 

Using the assay tool, you can create a table that shows if documents have been assigned 
nodes, values, and membership in sets.  To do so: 

1. Select the items you are interested in exploring from the left pane and add them to your 
assay table by clicking on the appropriate button under Add: (the appropriate button will 
highlight after you select each item).  You can move as many or as few items to the assay 
table as you would like. 

2. Once you have selected all of your objects to be included in your assay table, click on the 
Make Assay Table button. 

3. A table will appear that lists the selected documents and memos in the first column and 
all other items in individual columns to the right.  If a 1 appears in a cell, it means that the 
document associated with that particular row had been coded or assigned the value at the 
top of the column.    
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Creating Reports 

In NVivo, you can create reports about documents and reports about nodes.   The document 
reports list nodes within the document, whereas node reports list where a node appears across 
documents. 

To create a Node Coding Report: 

1. From the Project Pad, click on the Explore Documents button.   

2. Highlight the folder containing documents for which you would like a node report 
completed (I generally use the All Documents folder). 

3. In the Set menu, select Report on Coding from a Node…. 

4. Use the Choose button to select the node you are interested in and click on the OK button. 

5. Your Node Coding Report will appear in a new window. 

To create a Document Coding Report: 

1. From the Project Pad, click on the Explore Documents button.   

2. Browse through your documents and highlight the document for which you would like a 
document coding report completed. 

3. From the Document menu, select Make Coding Report. 

4. Click on the Choose… button to find the nodes you would like included in your report 
and click the OK button. 

5. Your Document Coding Report will appear in a new window. 
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Project Management 

Saving Your Project 
As with all programs, it is important to save your work at regular intervals to prevent loss of 
data.   

To save your project: 

1. From the Project Pad, under the Project Menu, select Save Project.  The shortcut for 
saving your project is to hold down the Ctrl key (windows) and the S key simultaneously.   

Backing Up and Restoring Your Project 
NVivo has a utility built into it that allows you to easily backup your data and also restore 
your data from the last backup.  Backups must be completed separately from saving.   

To backup your project: 

1. From the Opening Screen for NVivo, under the Project Menu, select Backup Project. 

2. In the Project Name: pulldown list, select the project you would like to backup.  If your 
project does not appear in the pulldown list, click on the Choose… button and choose the 
project folder you would like to backup. 

3. Once you have found the correct project, click on the Backup… button. 

4. Use the Save in: pulldown menu to select the location for your backup file. 

5. In the File name: text box, type in a name for your backup file and click on the Save 
button. 

To restore your project: 

1. From the Opening Screen for NVivo, under the Project Menu, select Restore Project. 

2. Click on the Locate… button to find the backup file for your project. 

3. Click on the Choose… button to select a folder for NVivo to place your restored files. 

4. In the Project folder name: text area, type in a name for your restored project (if you have 
selected the same location as your original project, the folder must be uniquely  named.) 

5. If you would like the project to open in NVivo as soon as it is restored, then check the 
box next to Open project once restored.   

6. Click on the OK button.  If it did not open right away, you should be able to open your 
project from the Opening Screen for NVivo. 
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